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1. Introduction

Primatte S-100 for Photoshop is a chromakey compositing plug-in. It allows the user to
take a foreground image of any resolution, shot against a single color background, and
replace that single color with similarly positioned background pixels. A greenscreen has
been provided with this package to allow you to experiment with the technology. It is a
good color background for most flesh tones. Primatte can be used with any color back-
ground with equal effectiveness.

Where Primatte is most effective is along the edges of the foreground objects and when
you have transparent or semi-transparent objects in the foreground. Primatte allows you
to keep such detail as wisps of hair, smoke, sheets of glass or water and many other ob-
jects that would be lost using conventional methods of keying. Using the patented Pri-
matte Polyhedral Slicing Algorithm, the plug-in separates color space in a unique manner
and blends edge objects transparently with blurred background pixels to give you the fin-
est foreground/background blending available. It also is very effective at removing fore-
ground ‘bluespill’, which is a word used to describe areas of the foreground that have
absorbed color from the background during the shooting procedure.

2. Installation Information

System requirements
Any system configuration that supports the Adobe Photoshop application is sufficient for
proper Primatte operation.

Installing Primatte from the CD-ROM
1. Insert the CD-ROM into the drive you want to install from.

2. Choose Run from the File menu in the Program Manager or Run... from the Start but-
ton in the Windows 95 interface.

3. Type d:\setup in the text box and click OK. If you're installing from another drive, type
the drive letter for that drive instead.

4. The installer will search for the Photoshop plug-ins directory and ask you whether you
want it installed there. It will also ask whether you need the Adobe Acrobat Reader in-
stalled. This application is necessary to display the on-line documentation. It will also ask
for a directory in which to install the sample images included with the plug-in.

5. When the installation is complete, start the Photoshop application and follow the direc-
tions in 3. Starting the Primatte Functionality

PRIMATTE sample files included with the application:

Primatte.8bf - This is the PRIMATTE plug-in. It will be installed in the \Photshop\plugins
directory on your harddisk drive.

PrimPCPS.pdf - This is the document you are reading. It is in Adobe Acrobat format and
can be read using the Adobe Acrobat Reader that was included on your installation disk
(if it wasn't already installed on your system). It can also be accessed from within the Pri-
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matte plug-in event window.

alex-fg.tif - This is a foreground image of a girl against a bluescreen (640x480 pixels).
alex-bg.tif - This is a background image of a street scene (640x480 pixels).
tabako-fg.tif - This is a foreground image of cigarettes in an ashtray (640x480 pixels).
tabako-bg.tif - This is a background image of a tabletop (640x480 pixels).

water-fg.tif - This is a foreground image of a small statue with water cascading on it
(640x480 pixels).

water-bg.tif - This is a background image of a clocktower (640x480 pixels).

3. Starting the Primatte Functionality.

« Start up the Photoshop application.

* Pull down the FILE menu and select Open...

* Find the desired directory, highlight the applicable foreground image and select OPEN.
 Again pull down the FILE menu and select Open...

» Find and highlight the appropriate background image and select OPEN.

* You will now have two images loaded and visible in the Photoshop window.

NOTE: For Primatte to work properly, the two images have to be the same size. You can
check the size of an image by highlighting the image and going into the /IMAGE pull-
down menu and selecting Image Size....

* Highlight the background image by clicking anywhere on the image window.

 Pull down the FILTERS menu and select COMPOSITE and then slide over and release
the mouse button on Primatte... This will bring up the following window.

Usze current image as foreground:

" with previously saved background image.
" with solid gray background.

{* Save current image to be used as background

1] 4 |

 Select Save current image to be used as background  and click on the OK button.
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NOTE: If you want to save the matte view of your completed composite in the alpha chan-
nel of your final composite image, you must do the following additional step. Select or
highlight the foreground image. Pull down and select the Photoshop /Windows/Pallettes/
Show Channels option.

Filter Select QIULGLLIIT
New Window

Zoom In
Zoom Out
Zoom Factor...

Show Rulers

Palettes Show Brushes
Show Options

BG.PICT (RGB, 1:1)
+FG.PICT (RGRB, 1:1) | Show Picker
i Show Swatches
Show Scratch

Show Layers
Show Channels
Show Paths

Show Info
Show Commands

Layerz | Channels ™. Pathz
| ik | Fe Cirl+0
o _L Red Ctrl+1
w E Green Ctrl+2
& I]B]ue Ctrl+3
Ha Ctrl+4 |
Rl i

» Hold down the SHIFT key and click on the #4 box at the bottom of the window.
» The #4 area of the window should now look like this...

E.' | . | [ LE LE) LSCLY R L)
& #a Chel+4

= i

=
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» After doing the composite, this #4 or alpha channel will contain the matte view.
« Highlight the foreground image by clicking somewhere on the image window.

» Again pull down the FILTERS menu and select COMPOSITE and then slide over and
release the mouse button on Primatte... This will again bring up the ‘image select’ win-
dow.

» Select Use current image as foreground:  with previously saved background im-
age and click on the OK button.

 This will bring up the Primatte event window.
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4. The Primatte Interface.

Operation  Wiew Background Zoom Help

[ Ealrs|= [, B

» The Primatte Window has an toolbar across the top. All of the icon features are also
available as pull-down menu items. Let’s take a break to look at the icon buttons in the
Primatte interface and briefly see what each of them does before we continue with the
tutoral.

Operation  Miew Background Zoom  Help

@ Bolicl= > B |ee] === |E| Q&

olv| 2

* The first four icon buttons on the left constitute the four basic operation steps that com-
prise the process of using Primatte. Let's take a look at those steps and what each of
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them do:

» This is the Auto Setup @ mode selection button. It is the first step in the Pri-
matte chromakey process and usually does 95% of your work for you. After select-
ing this button and while viewing the Composite view, you use your mouse and
cursor to select a sample of the background color. This is a blue or green color in
the case of the sample images provided with Primatte, but it could be any color.
This functionality is also available under the QOperation menu.

» This is the Select Background E mode selection button. After changing the
view to Matte, you use this mode to select and clean up any noise in the back-
ground area of the foreground image. This noise could be from film grain, video
noise, irregular background color or several other causes. This functionality is also
available under the Qperation menu.

* This is the Select Foreground E mode selection button. While still viewing
the Matte, you use this mode to specify color regions in the foreground that are
100% foreground. When you see dark areas in the foreground image area, they will
register with the program as transparent regions. To make them appear as solid
foreground, you must point and click on these dark regions while in the Select Fore-
ground mode. Pointing and clicking on them will make them white in color and,
therefore, 100% foreground. This functionality is also available under the Qpera-
tion menu.

» Thisis the Tune Colors ﬂ mode selection button. While viewing the Compos-
ite view, you use this mode to specify color regions in the foreground that have
‘bluespill’ and suppress them. This functionality is also available under the Qpera-
tion menu.

The next four buttons represent the options in the View menu:
. o] -
» Thisis the Composite view button. When selected, this displays the current
results of the foreground/background blending in the Primatte display window. It is

also the viewing mode used in the Auto Setup and Color Tuning modes discussed
above. This functionality is also available under the Yiew menu.

* This is the Matte g view button. This changes the window view to display the
‘key’ or matte data. This is a 256 color image with all degrees of foreground image
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transparency displayed as shades of gray between white and black. Black repre-
sents 100% background and white is 100% foreground. This functionality is also
available under the View menu.

* This is the Foreground J view button. To see the original foreground image
in the Primatte display window, press this button. This is useful for checking to see
if there are color changes or discrepancies between the final composite image and
the original foreground image. This functionality is also available under the View
menu.

» This is the Background ﬂ view button. To see the original background image
in the Primatte display window, press this button. This functionality is also available
under the Yiew menu.

NOTE: There is also a Background pull-down menu option. This is used to select
the type of background imagery used for “blending” colors during the Tune Colors
phase of the Primatte process. This means that when Primatte is getting rid of blue
reflections on the foreground object, it ‘blends’ colors from this special background
image to replace the blue. If you have a person in the foreground with blue on her
cheeks and she is being placed on a reddish background, Primatte uses red to re-
place the blue. This makes the foreground object look more natural in the new set-
ting. The three choices are Direct, Defocused and Solid Color. Direct uses the
original background image, Defocused uses a slightly defocused or blurred ver-
sion of the background image and Solid Color lets you select a single color to use
instead a modified background image. If you select Solid Color, you must also
choose the fourth option in the menu, Select Color. This will present you with a
Solid Reference Color window that allows selecting the desired color.

Fed 4 k127
Green A k127 .
Blue 4 k127

The next group of three buttons are the Undo options:
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* This is the Undo E button. After you have started to use the plug-in, this will
let you ‘undo’ the last change made to the composite. This plug-in supports up to
100 levels of undo depending on the amount of harddisk space is available. This
functionality is also available under the Operation menu.

NOTE: This option only undoes the Primatte operations. It will not undo View
changes or other plug-in operations.

REDOD
* This is the Redo M button. After you have started to use the plug-in, and have
‘undone’ one or more changes, this will let you ‘redo’ the changes. This function-
ality is also available under the Qperation menu.

SET
» This is the Reset ﬂ button. After you have started to use the plug-in, this will
let you reset all changes made to the images and return you the original configura-
tion. This functionality is also available under the Qperation menu.

NOTE: Under the Qperation pull-down menu there are two other related choices;
Mark Settings and Return to Mark. At any point during the compositing process,
you may choose Mark Settings , which essentially sets a ‘bookmark’ at that point
in the process. Selecting Return to Mark , returns you to that point. This useful if
you have invested some time in setting up the image to a certain point and then
want to experiment by making some radical image changes in different areas to
test the results.

» This is the Load Settings @ button. After you have completed a composite or
at any stage of compositing, you can save the current parameter set in a file. click-
ing on this icon brings up a standard Windows file save dialog box and lets you
name it and specify a directory and hard drive on which to store it. This functionality
is also available under the Qperation menu.

—
» This is the Save Settings button. If you have previously saved a Primatte
data set, you can load it and have it be automatically applied to the current image
by clicking on this icon. This functionality is also available under the Qperation
menu.

NOTE: Also under the Qperation pull-down menu there are two other related
choices; Load Settings and Save Settings . At any point during the compositing,
the user can save the current parameters to their harddisk or load previously saved
parameters by using these two operations. Selecting either of them will bring up
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standard Windows file load/save dialog windows allowing the user to select the de-
sired directory and harddisk.

The next two buttons represent the options in the Zoom menu:

 This is the Zoom In/Out E toggle button. It switches between zoom mode and
operational mode. After you select this button, your cursor changes to the ‘zoom
cursor’ and you may click on the left mouse button to zoom in on your image. The
location of the cursor determines where the zooming will occur. Holding down the
Alt key on your keyboard reverses this process and zooms out one level for each
left mouse button click. You may zoom in or out a maximum of 4 times (2x, 4x, 8X
and 16x). Clicking on the right mouse button cancels the zoom mode and returns
the image to it's original size.

« This is the Zoom Cancel £ putton. When you click on this button, your display
returns to the original image display size.

The next three buttons represent some other options in the Qperation menu:

* This is the Cancel @ button. Pressing this closes the Primatte Plug-in Display
Window, exits the plug-in, deletes all chromakey data generated and returns you
to Photoshop. This functionality is also available under the Qperation menu.

* Thisis the OK ﬂ button. Pressing this closes the Primatte Plug-in Display Win-
dow, exits the plug-in and applies the Primatte composited image to the Photo-
shop foreground image. This will make the Primatte window close and you will
notice that the foreground image window has been replaced by the composited Pri-
matte image. This functionality is also available under the Qperation menu.

» This is the Help E button. Pressing this brings up the Adobe Acrobat Reader
and displays an on-line version of this tutorial/manual.

NOTE: There is also a Process pull down menu with an option called Save matte
to alpha channel . This automatically saves the matte information into the alpha
channel on the final image. Save matte to alpha channel is only available if the
incoming foreground image has at least one additional channel (besides R, G and
B), and if the user has activated (or highlighted) all the channels in Photoshop be-
fore invoking Primatte. If there is more than one alpha channel, Primatte will write
to the first one.

Page 10



5. How to use Primatte

Continuing the tutorial, we will now use those buttons and controls to make a composite
using the sample images we have already loaded and passed to the Primatte event win-
dow.

» Ensure that the Auto Setup ﬁ button is pressed in.

NOTE: Auto Setup is the initial default. The other three buttons are disabled (grayed out)
until Auto Setup has been performed. Position the cursor in the bluescreen (or what ever
color was used for your chromakey background) area, near the foreground object and
click the left-hand mouse button down and let it up. This completes the Auto Setup
mode. Optionally, you may hold the left mouse button down and while holding it down,
sample a representative range of blue pixels by sliding the cursor around the blue area.
Do not let the cursor touch the foreground image pixels. Let off of the mouse button and
the software will automatically calculate the initial compositing parameters based on an
average of the pixels sampled. Which method you use is a matter of technique. Some
Images give a better result with a single pixel sample and others work better with a large
sample.

TIP: If the foreground image has a shadow in it that you want to keep in the composite,
do not select any of the bluescreen pixels in the shadow. If you sample the shadow blue-
screen pixels, the shadow will not appear in the final composite.

TIP: When clearing background noise from around loose, flying hair or other foreground/
background transition areas, be careful not to select any of the pixels containing hair col-
or. Leave a little noise around the hair and you can clean it up later in the Tune Colors
mode.

* Select the Matte view Q button and then set the Primatte Operation Mode to the Se-

lect Background mode by pressing the Select BG E button.

 This presents you with a view of the matte image or key being generated. If there are
any white regions in the dark, bluescreened area, it is noise and must be removed. Po-
sition the mouse over these areas and while pressing the left-hand mouse button, sam-
ple these noise regions. When you let up on the mouse button, Primatte will calculate
and clear the noise. Repeat this, as necessary, to clear all noise from the background
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areas.

Before Background Noise Removal After Background Noise Removal

NOTE: If it is necessary to zoom in on a particular region, click on the Zoom In/Out ﬂ
button on the Primatte icon bar. Then position the magnifying glass cursor onto the area
you wish to zoom up on. When you have zoomed into the interested area, click again on
the Zoom In/Out button and your cursor will again return to the Select Background arrow
cursor. This technique should be repeated, as necessary, until all noise is removed from
the background areas.

» Set Primatte to the Select Foreground operation mode by pressing on the Select
Foreground E button. Using the same technique as for Select Background , contin-

ue sampling the dark pixels in the foreground area until the foreground area is as white
as possible.
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Before Foreground Noise Removal After Foreground Noise Removal

» Select the Composite view Q button.

* Select the Tune Colors ﬂ mode selection button. You have now completed the first
three stages of a Primatte composite and you should have a composited image ready
for fine tuning.

* Using the Zoom In/Out E button, zoom into an area that has any bluespill reflec-
tions.

» Deselect the Zoom In/Out button.

* Position the cursor on a bluish area of the foreground image and click the left mouse
button down and up. The Color Tuning window will appear.

Color Tuning

De-Color 4 4 D'DDE‘
Clp High 4 ¥ [10.000 .
Clip Lo A 1 | 0.000 Selected Caolar

Cloze | Apply |

NOTE: Primatte will have registered the color you selected in the ‘Selected Color’ color
chip on the right side of the Color Tuning window. This color chip can now be modified
by the tuning sliders (De-color, Clip High and Clip Low). For most images, the De-color
slider is all that is required to remove any remaining bluespill.

» The more to the right the slider moves, the more of the background screen color (in this
case, blue) will be removed from the sampled pixels. The more to the left the slider
moves, the more the color in the color chip will move toward the original foreground im-
age’s color. As you move the slider, the sampled color in the color chip changes in real
time, accordingly. When you have the color you want in color chip, release the mouse

button and click on the Apply M button Primatte recalculates the adjustments and
automatically updates the image on the monitor. Repeat this technique as necessary to
eliminate all remaining bluescreen regions from the composited image.
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TIP: Move the De-color slider to the right until the blue tinge just starts to disappear and
then back it off to the left a little before clicking on the Apply button. Primatte works better
if you make several small samples to the blue edges rather than a single major one.

* You can use the other two sliders in the same way for different key adjustments.

* Clip Low Slider : The Clip Low slider controls the matte softness for the color
which is closest to the background color. For example, you can save lost rar-
efied smoke in the foreground by selecting the color in the Tune Colors mode
and moving the Clip Low slider to the left.

* Clip High Slider : The Clip High slider controls the matte softness for the color
which is closest to the foreground color. For example, if you have thick and
opaque smoke in the foreground, you can make it semitransparent by moving
the Clip High slider to the right after selecting the pixels in the Tune Colors
mode.

TIP: If the foreground image changed color dramatically during the fine tuning process,
you can recover the original color by selecting an area of the off-color foreground image
and moving the Clip Low slider slightly to the left.

TIP: If these final operations have changed the final compositing results, you may have
to choose the Matte view option in the Primatte window and again choose Select Fore-
ground or Select Background to clean up the matte.

* When you have completed these procedures and have a good composite, click on the

OK ﬂ button in the Primatte window icon bar to accept the Primatte data settings and
close the Primatte event window.

* This will remove the Primatte event window and return you to the original foreground
and background image windows. However, you will notice that the image in the fore-
ground image window has been replaced with the final composited image that was on
the Primatte event window.

« Also notice that if you selected Save matte to Alpha in the Process menu and had
opened the fourth channel prior to starting the Primatte event, you now have an alpha
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channel that will be saved with the image.

| Layers \1 Ehanneli\l\ Faths 4
= M rce 20 [
o -
-~ #1
m = Ereen 32
= [liloive %3
& n#4 %4
it
Rl M &

* You must now pull down the Photoshop Eile menu and select Save As... When the
standard Windows ‘Save As...’ file dialog appears, select a new name for the composited
image and hit the OK button.

6. The PRIMATTE Algorithm

The patented Primatte Polyhedral Slicing Algorithm is at the heart of the Primatte plug-
in. To use Primatte most effectively, it sometimes helps to understand how the algorithm
works. This is a brief explanation, to get a more extensive understanding, please contact
P.E. Photron for a Primatte White Paper which explains the algorithm in more detail.

Basically, Primatte separates all of the colors in the foreground image into four separate

categories. It does this by creating a 3D RGB color space for the foreground image and
building three polyhedrons, one within the other to separate the colorspace into four cat-
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egories.
Fed

“*-_____ __,.-#"
\ Blue A small polyhedron

While the polyhedrons are displayed as circular shapes in this drawing, in reality they
each have 128 surface facets that can be distorted into many different shapes to accom-
modate each unique foreground image. An example of what the small polyhedron can
look like is above on the right.

Category #1 is the small polyhedron and contains all of the pixels in the foreground image
designated as 100% background. This means these colors in the foreground will be re-
placed completely with pixels from the background image.

Category #2 is the region between the small polyhedron and the medium polyhedron.
These foreground pixels are designated as the transition pixels between the foreground
and the background. These pixels are where Primatte blends the original background
pixels with the foreground. Wisps of hair and smoke pixels are in this region.

Category #3 is between the medium and large polyhedrons. These pixels are 100% fore-
ground, but have bluespill suppression applied to them. This is for pixels in the center of
the foreground object. You want the bluespill suppressed, but you don’'t want background
pixels blended in.

Category #4 is reserved for 100% foreground pixels that are unchanged from the original
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image.

L%
Category #4: S Category#2 3 Category #2; S
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Foreground
Button
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Buttan 100% background

=l (sed tosupress (sed to make
Tl=  bluespill in the FG smole moe (used to restore
O foreground) transpare ) kst F1G detai)

The sliders do not increase the entire circumference of the polyhedron, They just bulge
or dent it in the particular color region that you selected prior to moving the sliders. After
you have selected a bluish pixel in the Tune Colors mode and are moving the De-color
slider, you are bulging the large poly and moving the selected color region from Category
#1 to Category #2. This will leave the region as 100% foreground, but suppress the blue
tinge. As another example, when you are in the Select Background mode, every time you
designate a region of white noise, the small poly enlarges slightly in that direction (as
shown in the above drawing) and makes those pixels 100% background. All foreground
colorsmustresideinone ofthefour categories.

6. Troubleshooting Guide

Problem : | don’t get the /Composite/Primatte option when | pull down the Filters menu.
Possible Solution : Check to see that Primatte.flt is installed in the \Photoshop\plug-ins
directory.

Problem : After the composite is complete, | have some stray pixels in the background
area that are not 100% background. | select Matte view and the pixels appear to be com-
pletely black. How can | get rid of these?

Possible Solution :Inthe Tune Colors mode, click on one of these pixels and then move
the Clip Low slider to the right a little bit. This will move those pixels closer to the original
background color.

Problem : After doing the ‘fine tuning’ procedure on a bluescreen image, | get a yellowish
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tint on the foreground object in the final composite. How do | fix this?

Possible Solution : You may have done too much decoloring in the Tune Colors stage.
It is best if you do several small incremental changes rather than one large decoloring.
To recover from this problem, you can use the De-color slider. Select a section that in-
cludes the yellowish color and move the slider to the left a small amount. This should re-
store the original color to the yellowish area. You may have to go back in and do some
more fine-tuning, but this time select only the pixels that contain some background color
and make them small areas. Adjust the slider to the left only a small amount. You can
also go to the Select Foreground mode and click once on the yellowish pixels. This
should also make the yellow go away.

Problem : | get a red halo around the foreground object after compositing.

Possible Solutio n: This could be because of non-linearity in the foreground image color
distribution. For PRIMATTE to deliver the best results, the foreground image should not
have any pre-processing done to it. This leaves the edges of the image with a linear color
distribution and allows PRIMATTE to do an excellent composite. If the foreground image
was pre-processed, the soft-keying will produce a false-color processed foreground and
result in a ‘halo’ effect.

Possible reasons for having a non-linear color distribution:

1) Edge enhancement filtering (a detail filter in the video camera) may have been applied
to the original foreground when it is scanned from film. [Solution] Re-scan the film without
filtering.

2) Poor filtering in the D1 4:2:2 to RGB decoding process. [Solution] Use a higher quality
D1 decoder.

3) Inappropriate picture gamma value. [Solution] Change the RGB gamma (or Red gam-
ma only) and save it. Use this image to composite in Primatte. After using Primatte, apply
the inverse gamma value to recover the original picture tone.

7. If you still have a problem...

Please contact our technical support department at:
Phone: 800-486-2674 or

Phone: 408-454-9100

FAX: 408-454-9600

E-mail: maxsupport@photoflex.com
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